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1. DESCRIPTION OF LABORATORY INSTALLATION 

Purpose of the work: using numerical simulation in Fluent program to estimate 

the effect of friction and heating on the subsonic air flow moving in a cylindrical pipe 

of unchanged cross-section, determine the velocity diagrams in the cross section of 

the gas flow, the change in static pressure and other parameters of the subsonic gas 

flow along the channel axis. Compare the data with the experimental data.  

The working site of the installation for this laboratory work (Fig. 1) is a 

vertical cylindrical tube with an internal diameter d = 9 mm and a length l = 930 mm, 

connected to the common vacuum system pipeline through a flow valve. 
 

 
Figure 1 - Scheme of the working area of the installation 

Atmospheric air from the room through the inlet pipe 1 is drawn through the 

pipe through a vacuum pump. The change in pressure drop in the pipe (change of air 

flow regimes) is effected by the flow valve in the pipeline or throttle 7 in the pipe 

(Figure 1). The air is heated by means of an electric spiral 5 wound around the pipe 

and fixed with a casing 3 with asbestos thermal insulation 4. Thus, based on what was 

said above, it can be assumed in the calculation that the working medium in the 

channel is air. The pressure and temperature at the inlet are equal to the 

corresponding parameters of the environment. The outlet pressure is equal to the 

backpressure measured during the experiment.  



2. CONSTRUCTION OF THE CALCULATION MODEL  

2.1 Construction of the calculation model 

As is known from previous studies, the calculation model is built in the Gambit 

program. At the first stage of constructing the model, the contour points of the 

channel will be constructed. Then, on their basis, the boundaries of the computational 

domain will be obtained with the help of arcs of a circle, segments and splines, which 

will form the basis for creating surfaces of a two-dimensional computational model. 

Table 1 – Coordinates of the profile of the investigated channel 

х, мм у, мм 

921 0 

921 -9 

0 -9 

-9 -20,5 

-9 11,5 

-25 -20,5 

-25 11,5 

0 0 

Coordinate X of the center of the rounding of 

the upper edge, mm 
2 

Coordinate Y of the center of the rounding of 

the upper edge, mm 
15 

Radius of the input circle r1, mm 16 

Coordinate X of the center of the rounding of 

the lower edge, mm 
2 

Coordinate Y of the center of the rounding of 

the lower edge, mm 
-24 

Radius of the output circle r2, mm 4,5 
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2.2 Construction of base points 

Using the following commands, the menu for building points by coordinates is 

called: 

Geometry  → 

 

Vertex 
 
→ 

 

Create vertex  
   

In the menu that appears, in the Global field (in the global coordinate system), 

one should alternately enter coordinates of all points in accordance with table 1. For 

example, the coordinates of the first point (921; 0) are entered, and then they are 

confirmed by pressing the Apply button. Similarly, you should enter all the points 

from the channel profile table. In the event of an error, the action can be canceled 

with the help of the button  ("cancel"). To see all the constructed points, you can 

use the button  ("enter into the screen"). The result of the image is shown in Fig. 

2. 

 
Figure 2 – Constructed baseline profile points 

2.3 Construction of the channel profile contour  

The channel profile is formed by two arcs of circles (the leading edge) and 

segments. It is most convenient  to begin construction from the segments. To do this, 

call the appropriate menu with the following commands: 
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Geometry  → Edge  → 

 

Create edge  
   

To build a channel outline, you must select the corresponding points in the 

order by using the mouse and pressing the Shift key. To accept the action, click the 

Apply button. The result of the action is shown in Figure 3.  

 
Figure 3 - Line construction menu and channel build result  

 

The next stage is the construction of the arcs that form the edges of the channel 

entrance opening. To do this, call the menu for building arcs (Figure 4): 

In this menu, you need to do the following: 

 

Geometry  → Edge  → 

 

Create arc  
   

–  in the Method column, you need to select the construction method (using the 

centre and two points); 

–  in the Center field select the center of the circle of the input edge; 

– in the End-points field select adjacent points of the input edge; 

– leave the Arc field unchanged; 

– Start the command with the Apply button 

The result of the command is shown in Figure 5. 
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Figure 4 – Arc Build Menu

 
Figure 5 – Result of constructing arcs 

2.4 Surface construction 

The basis for constructing a finite-element grid of a two-dimensional model is 

a surface. It is built using the surface build menu (Figure 6): 

Geometry  → Face  → 

From 

Wireframe  
   

In the appeared menu it is necessary to put the cursor in the Edges window and 

use the mouse to select the lines forming the closed contour of the calculation area. 

To build the surface, you should click the Apply button. As a result, the lines of the 

contour can change color. 
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Figure 6 – Menu for plotting surfaces using lines 
2.5. Specifying boundary surfaces 

To exit to the boundary conditions setting menu (Figure 7), press the following 

buttons in the main menu: 

Zones  → 
Specify 

Boundary Types  

 
Figure 7 – Boundary conditions menu 

In this menu, it is necessary to set the boundary condition pressure inlet and the 

boundary condition pressure outlet. The result of the construction of the boundary 

conditions is shown in Figure 8. On the rest of the model bounding surfaces, which 

were not marked as boundary surfaces, by default the wall boundary condition will be 

established(Wall). 
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Figure 8 – The result of setting the boundary conditions 

2.6  Construction of finite element mesh 

For the correct specification of the periodical boundary condition, it is necessary 

that the boundary data have a bound finite-element grid. You can establish the 

connection with the help of the following commands: 

 Mesh  → Edge  → Link edge  
In the dialog box that appears, use the mouse to select a pair of periodic 

elements, for example side lines of the input area, and confirm the execution of the 

command with the Apply button. 

To solve this problem with sufficient accuracy it is possible to use unstructured 

decomposition of the investigated channel. The surface is split using the following 

command: 

 

Mesh  → Face  → Mesh face  
As a result, the menu shown in figure 9 appears. 
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Figure 9 – The grid building menu 

It is required to perform the following manipulations: 

– In the Face field, select the surfaces that will be broken. 

– In the Elements field, the end element type is Quad (quadrilateral), Tri 

(triangular), or Quad / Tri (mixed). 

– In the Type field, select the Pave circuit, which is used to perform the 

debugging. 

– The Spacing field (Figure 9) introduces the required size of the final element 

(for example, 1mm). 

– For the construction of a finite-element mesh with the selected parameters, 

click the Apply button. 

The result of the command is shown in Figure 10. 

 
Figure 10 – The result of constructing a triangular unstructured finite element mesh 

To obtain more accurate calculations, it is proposed to thicken the finite 

element mesh only in places with large gradients of parameters. This action is 

performed using the Size Function menu (Figure 11), which is called by the 

command: 

Tools  → Size function  
 

 10 



 

Figure 11 – Size Function Menu 

In the appeared window in the Source field it is necessary to describe that the 

source of condensation is the Edges line. Then use the mouse pointer to select the 

lines next to which the thickening will take place. In the case under consideration, 

these are the walls of the channel. 

 In the Attachment field, select the element to which the size function will be 

applied. In the case under consideration, this is the surface of the computational 

model. Therefore, in the list  select Face and use the mouse pointer to mark the 

surface of the calculation area. 

In the Start size field enter the size of the final element near the surface of the 

thickening, for example, 0.075 mm. In the Growth rate field, the number of cells of 

the i + 1-th row is more than the cells of the i-th row (for example, 1.25). In the 

Max.size field, the maximum size of the finite element cells is entered, after which 

the thickening stops (for example, 1 mm). To apply the entered settings, click the 

Apply button. 

You can see the action of the Size Function command by re-constructing the 

grid on the surface of the model as it was done before. Before this, you must delete 

the previously built grid using the command:    

Mesh  → Face  → Delete face mesh  
Use the mouse to select the surface from which you want to remove the grid. 

The ‘Remove unused lower mesh’ button should be left clicked. This will remove the 

partitioning into the final elements of the faces (the relationship of the partition will 

not be violated). To confirm the deletion command, click the Apply button. The 
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result of dividing the computational domain by a triangular unstructured grid in view 

of the Size Function is shown in Figure 12. 

 
Figure 12 – The result of constructing a triangular unstructured finite element mesh 

with thickening near the walls 

2.7 Transfer of the constructed settlement model to Fluent  

To export the created model, select the following items in the upper menu: 

ВМ: File → Export → Mesh. 

In the appeared window, you need to enter the name of the exchange file and 

using the Browse button you can select the place where the file should be saved. 

Since the computational model is two-dimensional, it is necessary to click the Export 

2D (X-Y) Mesh button and then press the Accept button. 

2.8 Closing Gambit 

This action is performed by the command: 

ВМ: File → Exit.  
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3. CALCULATION AND ANALYSIS OF RECEIVED DATA  

The Fluent program runs and all other actions are performed directly in it: 

3.1 Reading a calculation model created in Gambit 

To execute this command, you need to select in the main menu: 

MM: File → Read → Mesh. 

In the appeared standard window of the Windows Explorer, you need to find 

the place where the exchange file was saved, select it and confirm with OK. 

3.2 Checking the finite element mesh for errors 

It is implemented with the help of the command:  
MM: Mesh → Check. 

If an error is found, a corresponding message will be issued. In this case, you 

need to return to the Gambit program, find the error and fix it. 

3.3 Scaling of finite element mesh  

Since the channel model was implemented in the Gambit module, and the 

dimensions of the computational models in the Fluent program must be set in meters, 

it is necessary to reduce the constructed grid by 1000 times. To do this, the program 

calls a special command from the main menu (Figure 13): 

MM: Mesh → Scale. 

 

Figure 13 – Scale Mesh Men 

In the Scale Mesh menu in the Mesh was created in field, you must select 

millimeter mm (or another unit of measurement in which the calculation model was 

created), and then click the Scale button. Scaling will be done. After the operation is 

completed, the menu must be closed using the Close button. 

3.4  Viewing a finite element grid 

To view the finite element mesh of the model under study, it is possible with 

the help of the command: 
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MM: Display → Mesh. 

 

Figure 14 - Mesh Display Menu 

In the Surfaces window (Figure 14), you need to select all the boundary 

surfaces that the user wants to view. After performing these manipulations, you need 

to press the Display button. As a result, the calculated grid appears in the graphics 

window (Figure 15). 

 
Figure 15 - Result of displaying the grid 

 
3.5 Setting the Solver Options 

When solving this problem, it is necessary to choose a solver with the help of 

which a solution will be made. This choice is made with the help of the Solver 

command: 

MM: Define → General. 
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Figure 16 - The Solver Menu 

And in this menu (Figure 16) you need to set the following settings: 

In the Solver field, you should choose the algorithm for solving the problem 

under consideration. It is advisable to select Pressure Based; 

In the 2D Space field, Planar is selected - flat; 

in the Time field it is established that the solution of this task will be Steady or 

Transient (in this task - Steady).Рисунок 16 - Меню Solver 

3.6 Accounting for the calculation of the energy equation 

When solving this gas dynamics problem it is necessary to take into account 

the change in the flow temperature and heat exchange. Therefore, you should connect 

the energy equation to the solution using the command:  

MM: Define → Models→ Energy. 

In the window of this program, check the Energy Equation box and click OK. 

3.7 Determination of the model of turbulence 

To specify the model of turbulence, select the command: 

MM: Define → Models→ Viscous. 

To solve the problem in the list of turbulence models, it is necessary to select 

the turbulence model k-ε (k-epsilon). In the menu that appears, the RNG model is 

marked and a tick in the Viscous Heating column is used to account for the heat 

released from the viscous friction of the gas layers. 

3.8 Setting the properties of the working body 

This operation is performed in the Material menu (Figure 17):  

ГМ: Define → Materials. 
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The working body in this task is air, which in the default Fluent program 

settings. When solving problems of gas flow in canals with heating, one should take 

into account the compressibility of the body. Therefore, it is necessary to determine 

the dependence of the gas density on the flow parameters. To do this, use the 

equation of state of an ideal gas (Mendeleev-Klaiperon) and therefore 

In the Materials menu, in the Density list, select Ideal-gas. 

 

 
Figure 17 - The Materials menu 

The dependence of viscosity on temperature is usually given in the form of the 

Sutherland equation:  

CT
CTμμ

+
+

=












 2732
3

2730 . 

To describe this in the program on the Materials menu in the Viscosity list, 

select Sutherland. All changes to the properties of the working body are saved by 

pressing the Change / Create button. After the operation is completed, the menu 

should be closed with the help of the Close button. 
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3.9 Setting the reference pressure 

As a "reference pressure", 0 should be taken to ensure that the calculation 

results and the initial data are specified in absolute values. You can change the value 

of "reference pressure" in the menu that appears as a result of the command:  

MM: Define → Operating Condition. 

To simplify the processing of results in the problem being solved, it is 

advisable to take "reference pressure" equal to zero, and enter its value in the field 

Operating pressure.  

3.10 Setting Boundary Conditions  

The Boundary Condition command calls the menu for setting boundary 

conditions (Figure 18): 

MM: Define → Boundary Condition. 

 

Figure 18 - Boundary Condition menu 

Then, in the Zone window, select the desired boundary condition, be sure that 

in the Type window, the type of the boundary condition is specified correctly, and 

click then Set. As noted above, the following conditions will be met in the problem 

under consideration: 

– at the output boundary, a static pressure equal to the back pressure, which is 

recorded during the experiment, is set; 

– at the input boundary, the total pressure is set equal to atmospheric pressure; 

– the heat exchange condition is set on the channel walls.  

The input boundary condition "pressure-inlet" is set in the following sequence 

(Figure 19): 
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Figure 19 - The menu Pressure inlet 

In the field Gauge Total Pressure is entered the value of the total pressure at 

the entrance to the calculation area. In the problem under consideration, it is equal to 

atmospheric. 

The Supersonic Gauge Pressure field specifies the static flow pressure for this 

case. The flow velocity at the inlet to the channel is zero, and therefore in this field 

the pressure is equal to atmospheric pressure. 

In the Direction Specification Method field, the direction of the velocity vector 

at the input boundary is determined, which in this case is normal to the input 

boundary. Therefore, in the Direction Specification Method field, select Normal to 

Boundary (perpendicular to the border). 

To set the full flow temperature at the input, click on the Thermal tab at the top 

of the menu, and enter the temperature value in the available Total Temperature field. 

For the example under consideration, the temperature is equal to the atmospheric 

measured during the experiment. 

Similar settings are made to set the boundary condition on the output border in 

the Boundary Condition menu, where you need to select the name of this border and 

press the Set button. This will cause the Pressure Outlet menu (Figure 20) to appear, 

in which settings similar to the Pressure-inlet must be made. 
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Figure 20 – The Pressure Outlet Menu 

In addition to the boundary conditions listed above, the boundary condition of 

the wall (wall) is present in the problem being solved, which is heated from the 

outside of the channel. Therefore, in the boundary condition Wall (Figure 21), the 

value of the heat flux is set. Heat Flux=17321w/m2. 

 
Figure 21 - Wall Menu  

3.11 Setting account parameters   

The menu for setting account parameters is invoked with the command:  

MM: Solve → Methods. 

The Solution Methods menu appears on the screen (Figure 22). 

 

 19 



 
Figure 22 – Menu Solution Methods 

In this menu, you need to make the following settings: 

In the Spatial Discretization zone, the first order of sampling should be set at 

the beginning of the calculation, and then it should be increased. 

In the Pressure-Velocity Coupling zone, it is advisable to select the Coupled 

algorithm to solve the problem of the current in the channel under investigation, and 

to improve stability and convergence, reduce the Courant number to 50.  

3.12 Setting Initial Values for the Parameters   

The menu for setting the native conditions (Figure 4.23) is called by the 

command: 

MM: Solve → Initialization. 

In the Compute From field of this menu, you must select the input border. As a 

result, the recommended values of the initial parameters will be calculated from the 

input boundary conditions. To accept them, click Initialize. 
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Figure 23 – Initial settings menu 

3.13 Configuring the display of the solution process   

To monitor the residuals in the calculation process, and also to set the stopping 

criterion for the solution, you must call up the Residual Monitors menu (Figure 24) 

using the command: 

 MM: Solve → Monitors→ Residual. 

 
Figure 24 – Residual Monitors menu 

In the Option field, check the boxes next to Plot and Print, which will allow 

you to see the discrepancies on the screen. In the Convergence Criterion field, in 
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order to obtain a fairly accurate solution of each equation, it is necessary to set the 

value of the residuals 10-3 (except 10-6 for the energy equation). 

To visualize the change in the cost difference between the input and output 

boundaries in the solution process, you need to call the command: 

MM: Solve → Monitors→ Surface→ Create 

The menu shown in Figure 25 appears. 

 
Figure 25 - Define Surface Monitor Menu 

In this menu, the Mass Flow Rate item is selected in the Report Type field, and 

the input and output limits are selected in the Surfaces list. 

3.14 Saving calculation model  

It is carried out by means of a command call: 

MM: File → Write → Case. 

Then, in the Explorer window that appears, select the area where the model and 

its name will be saved. 

3.15 Running the solution 

It is carried out by selecting the command: 

MM: Solve → Run Calculation. 

In the Number of Iteration field, enter the number of iterations (for example, 

1000), and then the Calculate button is pressed. After the solution is started, the 

dependence of the residuals on the iteration number for each equation appears in the 
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graphics window (Figure 26), as well as a window showing the change in the 

difference in the flow rates (Figure 27). As soon as the residual values for each of the 

equations have reached the specified values, immediately the Fluent program remains 

the solution and will display message «solution is converged» 1 in the message 

window. 

 
Figure 26 – Variation of discrepancies by iteration 
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Figure 27 - The change in the difference in costs between the input and the output by 

iteration 

3.16 Increase in the order of sampling 

The implementation of this procedure will allow obtaining more accurate 

calculation results. To do this, you need to go back to the Solution Methods menu 

(Figure 28): 

MM: Solve → Methods. 

After that, in the Spatial Discretization field, in front of all solved equations, 

you should set the Second Order Upwing. Then the calculation starts again. The 

calculation resumes from the place from which it was stopped, but with the new 

settings of the controller, using the achieved results as a first approximation. 
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Figure 28 - The Menu of the Solution Methods 

3.17 Visualization of the distribution fields of parameters in the calculation area  

To do this, run the command: 

MM: Display → Contours. 

As a result, the Contours menu appears (Figure 29). In the Filled window of 

this menu, you must set the check box to watch the parameter distribution fields, and 

then select the parameter in the Contours of field whose modification you want to 

display. Thus, by performing the necessary settings in this menu, you should obtain 

the fields of distributions of the total and static pressures, temperatures, flow velocity 

in the channel (Figure 30 ... 32). 
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Figure 29 – Menu Contours 

       
Figure 30 – Static pressure field in the channel 
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Figure 31 – Full pressure field in the channel 

       
Figure 32 – Static temperature field in the channel 
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3.18 Visualization of velocity vectors 

To display the velocity vectors in the calculation area, use the Vectors menu 

(Figure 33), which is started with the command: 

MM: Display → Vectors. 

 

Figure 33 – Vectors menu 

The size of the vectors can be changed in the Scale field, and the number of 

vectors can be reduced by setting a non-zero number in the Skip field. This number 

determines how many vectors will not be displayed. As an illustration, the 

distribution of vectors at the entrance edge of the channel is shown in Fig. Setting a 

checkmark in the Mesh field opens access to the grid display menu. This makes it 

possible to simultaneously display the grid and the distribution fields of the 

parameters (Figure 35). 

 
Figure 34 – The distribution of vectors near the channel's leading edge 
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Figure 35 – Simultaneous representation of vectors and grid 

3.19 Creating graphs for changing parameters 

Then it is necessary to plot the distribution of any calculated parameter along 

an arbitrary surface or line. 

In this work, it is necessary to plot the velocity, total and static pressures, total 

and static temperatures, gas density, Mach number along the channel axis Y = 0. 

To begin with, build the necessary surfaces with the command: 

MM: Surface → Iso Surface 

In the Surface of Constant field, select the grid (Mesh) →Y-Coordinate. In the 

Iso-Values field, a coordinate is plotted along the Y axis through which the plane 

must pass (in our case, Y = -0.0045m). Under the New Surface Name, the name of 

the created plane is written, for example Y = -4.5mm. To create a plane, click on the 

Create button. Then the build menu opens, which is called with the command: 

MM: Plot → XY-plot. 

In the XY-plot menu, tick the Position on Y Axis check box. In order to 

construct a change in the total pressure at the exit boundary, it is necessary to select 

the total pressure (Pressure → Total Pressure) as the parameter on the y-axis, and the 

coordinate x (Mesh → Y-Coordinate) as the parameter along the x-axis. In the 

Surfaces field, you specify the surface or line on which the distribution is constructed 

(in the example under consideration, Y = -4.5mm). To create a graph of the settings 

made, you need to press the Plot button. The changes in other parameters are 
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constructed analogously. If you tick the checkbox in the Write to file box, the 

resulting graph can be written to a text file that can be used in the future either in the 

Fluent program or in other programs, for example MS Excel. 

Graphs of temperature, pressure and velocity distribution are shown in Figures 

36 – 40. 

 

 

Figure 36 – Graph of the distribution of static pressure along the length of the channel 
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Figure 37 – Graph of the distribution of total pressure along the length of the channel 
 

 

Figure 38 – Graph of the distribution of the static temperature along the length of the channel 
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Figure 39 – Graph of the distribution of the total temperature along the length of the channel 

 

Figure 40 – Schedule of velocity distribution along the length of the channel 
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4. ADDITIONAL TASK №1 

With the help of numerical modeling in the Fluent program, it is necessary to 

additionally estimate the influence of friction and heating on the subsonic air flow 

moving in a cylindrical pipe of unchanged cross-section, determine the velocity 

diagrams in the cross section of the gas flow, the change in static pressure and other 

parameters of the subsonic gas flow along the channel axis. 

Law of treatment of impacts 

The parameters of the gas flow vary only when the environment is exposed to 

it. In this case, the following environmental impacts on gas (gas-dynamic system) are 

possible:  

1. Geometric (ds) - change in the size of the channel cross-section along the 

flow (expansion or narrowing of the channel); 

2. Expendable (dG) - change of mass flow rate of gas in the channel by supply 

or withdrawal of additional mass through the side surface; 

3. Mechanical action (dl_tech) - the exchange of mechanical energy in the 

form of technical work between the flow of gas and the environment (the 

operation of a turbine or compressor); 

4. Thermal action (dq_n) - supply or removal of heat; 

5. Effects of friction (dl_tr) - taking into account the influence of the really 

existing viscous friction forces within the ideal gas model. 

Depending on the sign of each exposure, this influence in the opposite way 

affects the parameters of the subsonic and supersonic flows. The influence of this or 

that effect on the parameters of a subsonic or supersonic flow can be determined from 

the equation of the law of inversion of influences. This equation is obtained from a 

joint solution of a system of four equations-continuity, energy in thermal form, 

energy in mechanical form (Bernoulli's equations), and states recorded in a 

differential form: 
dρ
ρ

+ dw
w

+ ds
s

= 0;     (1) 

dqн − dlтех = сpdT + wdw;    (2) 

−dp
ρ

= wdw + dlтех + dlтр;     (3) 



dp
ρ

= RdT + RT dρ
ρ

;     (4) 

where w, p, T и ρ – velocity, pressure, temperature and gas density, R is the specific 

gas constant, s is the cross-sectional area of the channel, lтр is the hydraulic loss 

(work of frictional forces associated with the viscosity of the gas), сp is the specific 

heat at constant pressure. 

Substituting expressions 1-3 into equations 4 and carrying out the 

transformations, we obtain the equation of the inversion law: 

(M2 − 1) dw
w

= ds
s
− dG

G
− k−1

a2
dq − 1

a2
dlтех −

k
a2

dlтр  (5) 

In this equation: M is the Mach number, a is the speed of sound, k is the 

exponent adiabats. 

From equation 5 follows: 

- any physical impact of the same sign in the opposite way affects subsonic and 

supersonic gas flows; 

- transition through the speed of sound with the help of one-sided action is not 

possible. This phenomenon is called the current crisis; 

- transition through the speed of sound is possible only if in the critical section 

the sign of influence is changed to the opposite one. 

In order to realize the thermal effect on the flow, it is necessary to set the 

temperature in the Thermal tab in the Thermal tab at the setting of the boundary 

conditions in clause 3.10 in the boundary condition of the wall (Figure 4.41). Next, 

you need to make the settings in accordance with paragraphs 3.11-3.16 and start the 

calculation. Analogous calculations must be made at a wall temperature of 400, 600 

and 900 K. Upon completion of the calculation, it is necessary to visualize the 

distribution fields of static pressure, total pressure and temperature (Figure 42-52). 
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.  

Figure 41 – Wall Menu 

 
Figure 42 – Fields of distribution of static pressure in the channel at temperature 

300 K walls  
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Figure 43 – Fields of distribution of static pressure in the channel at temperature 

walls 400 K 

 
Figure 44 – Fields of distribution of static pressure in the channel at temperature 

walls 600 K 
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Figure 45 – Fields of distribution of static pressure in the channel at temperature 

walls 900 K 

 
Figure 46 – Fields of distribution of the total pressure in the channel at a wall 

temperature of 300 K 
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Рисунок 47 – Поля распределения полного давления в канале при температуре стенки 400 К 

 
Figure 47 – Fields of distribution of the total pressure in the channel at a wall 

temperature of 400 K 
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Figure 49 – Fields of distribution of the total pressure in the channel at a wall 

temperature of 900 K 

 
Figure 50 – Temperature distribution fields in the channel at a wall temperature of 

300 K 
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Figure 51 – Fields of temperature distribution in the channel at a wall temperature of 

400 K 

 
Figure 52 – Fields of temperature distribution in the channel at a wall temperature of 

900 K 
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Also, similar to paragraph 3.19, it is necessary to plot the changes in the 

parameters of static pressure, total pressure, static temperature, total temperature and 

velocity along the channel length (Figure 43-57). 

 
Figure 43 – Graph of the distribution of the total pressure along the channel 

length at a wall temperature of 300 K 

 
Figure 44 – Graph of the distribution of total pressure along the length of the 

channel at a wall temperature of 400 K 
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Figure 45 – Graph of the distribution of the total pressure along the length of 

the channel at a wall temperature of 900 K 

 
Figure 46 – Graph of the distribution of static pressure along the length of the 

channel at a wall temperature of 300 K 
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Figure 47 – Graph of the distribution of static pressure along the length of the channel at a 

wall temperature of 400 K 

 
Figure 48 – Graph of the distribution of static pressure along the length of the channel at a 

wall temperature of 900 K 
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Figure 49 – Graph of the distribution of the total temperature along the channel 

length at a wall temperature of 300 K 

 
Figure 50 – Graph of the distribution of the total temperature along the channel 

length at a wall temperature of 400 K 
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Figure 51 – Graph of the distribution of the total temperature along the channel 

length at a wall temperature of 900 K 

 
Figure 52 – Graph of the distribution of the static temperature along the 

channel length at a wall temperature of 300 K 

 45 



 
Figure 53 – Graph of the distribution of the static temperature along the 

channel length at a wall temperature of 400 K 

 
Figure 54 – Graph of the distribution of the static temperature along the 

channel length at a wall temperature of 900 K 
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Figure 55 – Graph of the distribution of the flow velocity along the channel 

length at a wall temperature of 300 K 

 
Figure 56 – Graph of the distribution of the flow velocity along the channel 

length at a wall temperature of 400 K 
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Figure 57 – Graph of the distribution of the flow velocity along the channel 

length at a wall temperature of 900 K 

On the basis of the data obtained, it is necessary to plot the Mach number, the 

flow velocity and the total pressure from the wall temperature.  
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5. ADDITIONAL TASK №2 

1. Calculate the process of flow of the working fluid in the channel without 

heating its wall. To do this, in the boundary condition of the wall (wall), the value of 

the heat flux is set to zero (Heat Flux = 0 w / m2). Then repeat all the steps from 

Step 18 to Step 27 

2. Change the output value of pressure p0 in accordance with the experiments. 

If experiments were not carried out, then establish the following pressures at the exit 

section of the channel: p0 = 85000Pa, p0 = 45000Pa. Repeat for each version of the 

pressure output all steps from Step 16 to Step 27. 

3. Change the working medium that is current in the channel and analyze the 

calculation results (Step 16 - Step 27). 

4. Change the output pressure value p1 * and repeat all the steps from Step 16 

to Step 27. 

5. Compare the results obtained during the processing of the training 

experiment with the results of numerical simulation. 

6. Analyze the data and draw conclusions. 
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